
 

Welcome to sPlan 6.0
 
sPlan is an easy-to-handle and comfortable CAD-software, developed for electronic and electric
circuit diagrams. Dragging and dropping components from the library to the diagram is as easy as
it can be and components fit exactly to the grid.
 
All components and drawing elements are free editable on your circuit diagram. You can build
groups, move, rotate, cut, copy, paste, delete,...
 
sPlan is equipped with lots of features like automatic component numbering and auto-generation
of component lists.
 
sPlan produces high-quality printouts, which can be previewed to adjust scale and position of the
print. All changes will take effect in the preview immediately.
 
The well-sorted library contains lots of parts, components and symbols. You can extend the
library with your own components as you like.
 
We have spent much time to create an easy-to-handle software. After a short settling-in period
you will see how easy it can be to create perfect circuit diagrams.
 
You can get more informations and updates on our homepage www.abacom-online.de/uk
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New features of sPlan 6.0
 
Free rotating and shearing
You can rotate and shear all elements without limits. In older versions of sPlan there was only a
rotating function for 90° available.
 
Rubber band
With the rubber band function you can move components together with their connections.
 
Snap to connections
This new function makes it easier to connect components exactly. As soon as you come in the
near of a connection, the position will be captured exactly on the connection.
 
Bezier curves
With these curves you can now draw  curved lines.
 
Arrow styles for lines
All lines can start or end with arrows or other symbols.
 
User variables
You can now define your own variables. These variables are wildcards for any text. If you change
the text of a variable, the text will be replaced automatically, everywhere you have used this
variable. You can even use these variables in component identifiers or contacts.
 
Text constants
You can save often needed text elements as text constants. These text constants are available at
any time you need them.
 
Drawing mode for special forms
A new drawing mode is available for drawing polygons, stars, tables or sine curves. You can
define the geometrical properties and draw the form in one go.
 
JPG format
sPlan supports now the import and export of the JPG format.
 
Active Links
You can place links on your circuit diagram and interconnect them with other places everywhere
you want. Once you have defined active links, you can follow them with just one click. Even links
into the internet are possible.
 
Improved component list functions
The new export function allows you to import your component lists e.g. to Excel, or other
programs.
The improved "collect values" option is now working with components which are designated
manually (without automatic numbering) too.
 
Free zero point on the coordinates
The zero point for the coordinates and the rulers can be adjust as you like.
 
Improved support for the mouse wheel
With the mouse wheel you can either scroll or zoom (with pressed CTRL-Key) just like in many
other CAD programs.
 
Improved printing function
You can now define a collection of pages, you want to print in one go.



 
Line splitting
You can now split long lines everywhere you want into 2 separate lines.
 
More comfortable magnetic lines
You can easily drag new magnetic lines from the rulers. If you want to delete magnetic lines, just
drag them back to the ruler.



Main screen
 

 
Let's have a look at the sPlan software and its sections. On the top of the main window you find
the main menu and the toolbar. sPlan displays short hints, when you move the mouse to control
elements like buttons and stay there for a moment.
 
On the left side you can find the component library with a light blue colored background. You can
drag components from the library and drop them to your diagram. To adjust the width of the
library section, move the mouse cursor to the right border of the library. The cursor will show a
split symbol. Hold down the left mouse button and adjust the width by moving the mouse.
On the bottom of the library some buttons offer additional library functions.
 
The vertical toolbar right from the library contains several tool buttons, to activate different
editing and drawing modes.
 
Diagrams are drawn on the light yellow area of the application. On the bottom of this drawing
area you find a register that contains entries for each page that your project consists of. Simply
click to one of these entries to show and activate one of the pages.
 
A status bar on the bottom of the main window displays information about mouse position, line
settings, etc. Here you can also define important parameters like snap grid on/off or the value of
the angle grid.



Page properties
 
The first thing to do is to define the paper format that you want to use for your diagram. There
are two possible ways to do this. You can select PAGE SETUP from the PAGE item of the main
menu or you can click with the right mouse button to the PAGE REGISTER (at the bottom of the
diagram) and select PAGE SETUP from the local context menu.
 

 
A dialog will appear that allows you to enter the format, the orientation and the name for the
current page. You can call this dialog whenever you want to make changes to one of the page
properties.
 



Adjusting the grid
 
When editing a diagram with sPlan, normally a grid will be active. The grid is very helpful to place
elements and for connecting components with lines. The default value for the grid is 1mm.
Generally this will be a good value, but you can change this value if necessary. The grid distance
is saved for each individual project file and can be changed by selecting Options -> Adjust
grid... from the main menu. The grids dialog allows you to enter the grid distance in steps of
1/10 mm (10 = 1 mm). You can also select whether you want to have the grid VISIBLE in the
editor, or not. Depending on the zoom adjustment some grid points suppressed, to keep the view
of the diagram readable, but the grid will still remain active. In that case increase the zoom
adjustment to make all grid positions visible.
 
You can also call the grid dialog, using the grid button from the toolbar. If you have to change
grid values regularly for some reasons, you can click to the downward pointing arrow right from
this tool button to select often-needed grid values.
 

 
The option "more contrast" may be useful with some older LCD displays and produces darker grid
lines.
 
Tip:
If you want to have the grid capture deactivated temporary, hold down the SHIFT key on your
keyboard. The grid will be turned off, until you release the SHIFT key.
 
You may also turn off the grid capture completely, using the corresponding button in the status
bar at the bottom of sPlan.
 

 
In that case the grid is still visible, but the capture is turned of.



Rubber band
 
The rubber band function should help to keep the connections together while moving single
components or other elements. If a connected component is moved while the rubber band
function is enabled, the component takes all connected lines with it.
 

 With this button in the statusbar of sPlan you can enable or disable the rubber band function.
 
sPlan can only detect connected elements, if they are properly connected. If a line is overlapping
a connection of a component, this connection will not detect as "connected". The rubber band
function will also not work if 2 components are connected directly (this means without a line
between). In this case there exists no line, which the rubber band could take with.
 
After you have moved a component with the rubber band function, is is in most cases necessary
to adjust the connection line(s). If you select the line you can move the line nodes with the
changer . You can even add or delete nodes of the line. Just click with the right mouse button on
a changer and select add or delete.



Snap to connections
 
The snap-to-connections function is a very useful feature of sPlan. This function activates, in
addition to the general grid snap, an automatic snap at all connection-points. A connection-point
can be any line node or any start and end point of a circle or bezier curve.
 

 With this button in the statusbar of sPlan you can enable or disable the snap-to-connections
function.
 
As soon as you get near a connection-point in a corresponding action, the connection-point will
capture the mouse position. A red square will be displayed, to indicate that the mouse position is
currently captured by a connection-point. This capturing helps you to connect your elements in a
very accurate way.
 



Select, move, turn and delete elements
 
Selecting elements
After you have drawn some elements, you may want to change their position, size, color, etc. To
make any changes to an element, you have to select it at first. Therefore you have to activate the
default edit mode and select the element with a single mouse click. Click exactly to the elements
outline, if the element has no filled areas.
 
Selected elements are always drawn in magenta colors, and they are surrounded with 8 little
black squares, the sizer .
 
To select more than one element you can draw a frame. All elements, that cross the frame will be
selected. You can also hold the SHIFT key of your keyboard and click to a single element, to add
this element to the selection. Click again to unselect a single element, while holding the SHIFT
key. To unselect all elements click to an unused area of the diagram.
 
Moving elements
Select all elements you want to move. Click to the outline of one of the selected elements, hold
the left mouse button, and move the elements to their new position. You can also use the arrow
keys of the keyboard to move selected elements.
 
Deleting elements
Select all elements, you want to delete. Then select EDIT->DELETE from the main menu or
press the delete button from the toolbar. You can also use the DEL -key from the keyboard, to
delete all selected elements.
 
 
Rotating, scaling and shearing
Selected elements can be rotated, scaled or sheared in any way you like. You need only your
mouse to control all these functions. Just use the sizer and changer .



Sizer and Changer
 
Sizer
When selecting one or more elements, eight tiny black rectangles are displayed all around the
selection - the so-called SIZER.
 

 
Use the sizer to scale the selected elements. Move the mouse to one of the sizer. The mouse
cursor will change to show the direction of sizing. Click to the sizer and move the mouse while
holding the left mouse button down. Release the mouse button when finished.
 
If you click on a selected element again, the sizer rectangles will change into arrows.
 

 
With these arrows you can rotate and shear the element. To rotate the element, just click on one
of the 4 round arrows in the edges. Keep the mouse button pressed, and move the mouse around
the element to control the rotational angle. The rotation angle will be always snapped, as you
defined the rotation angle snap in the status line of sPlan.
 

 
If you press the CTRL-Key while rotating, you can disable the rotating angle snap temporary.
 
 
Changer
Some elements offer so-called CHANGER. The changer are small white rectangles on the outline
of the element, which are used to move significant points of an element.
 



 
With the changer, you can change the following elements:
 
Lines, polygons:
You can move any node of the line or polygon. You can click with the right mouse button on a
changer to add a new node or to delete a node.
 
Bezier curves:
You can move the start, end and the control points of the bezier curve.
 
Circles:
The changer defines the start and end point of the circle. You can use this to create circle
segments.
 
Rectangles:
The changer adjusts the rounding of the 4 corners of the rectangle.



Drawing functions
 
sPlan offers all drawing elements you need to create high-quality and nice-looking circuit
diagrams:
      

Rectangles, rounded rectangles
Circles, ellipses and circle segments
Polygons (closed areas with or without filling)
Special forms (regular polygons, stars, tables and sine curves)
Lines
Bezier curves
Connection points
Text labels
TextRect (for explanations, etc.)
Bitmaps (Logos, graphics, etc.)

 
To draw one of these elements click on the corresponding button of the vertical toolbar right
beside the library.
 
To select and edit your elements, you should return to the default edit mode (arrow). You can
easily return to the default edit mode, by pressing the right mouse button while the mouse cursor
is somewhere on your diagram.
 
If you press the right mouse button again (in default mode), a local popup menu opens and
offers often needed functions.



How to draw (rounded) rectangles
 

 Select the RECTANGLE mode from the mode section.
 
Click to the start position of the rectangle and hold the mouse button down. Move the mouse to
the rectangles stop position (bottom right) and release the mouse button. The rectangle is now
created, and you can go on with another one.
 
You can press the CTRL-key while you are drawing a rectangle to force an exact square.
 
When you finished drawing rectangles, return to default edit mode (arrow), to change its size or
properties. Use the changer to round the corners of the rectangle.
 
The rectangle will always be created with the currently selected preferences .
 
With a doubleclick on the rectangle you can edit its properties like pen, brush, etc.



How to draw circles, ellipses and circle segments
 

 Select the CIRCLE mode from the mode section.
 
Click to the start position of the rectangle and hold the mouse button down. Move the mouse to
the end position (bottom right) and release the mouse button. The circle is now created, and you
can go on with another one.
 
You can press the CTRL-key while you are drawing a circle to force an exact circle instead of an
ellipse.
 
When you finished drawing circles, return to default edit mode (arrow), to change its size or
properties. Use the changer to define the start and stop points of the circle. So you can create a
circle segment.
 
The circle will always be created with the currently selected preferences .
 
With a doubleclick on the circle you can edit its properties like pen, brush, etc.



How to draw polygons
 

 Select the POLYGON mode from the mode section.
 
The first click marks the start point of the polygon. Click again at another position to mark the
next point, and so on.
 
If you have finished the polygon press the right mouse button. The polygon will now be closed
automatically. You can now start with another polygon. Press the right mouse button again, to
return to the default edit mode.
 
When you have finished drawing polygons, return to default edit mode (arrow), to change its size
or properties. Use the changer to move the nodes of the polygon. You can even add or delete
nodes from your polygon. Click with the right mouse button on a changer to add a new node or
to delete a node.
 
The line's angle is captured to a certain value, which is displayed in the status bar.
 

 
Click on the display to select another value. To turn off the angle capture temporary hold down
the CTRL-key of your keyboard.
 
The polygon will always be created with the currently selected preferences .
 
With a doubleclick on the polygon you can edit its properties like pen, brush, etc.



How to draw special forms
 
The "special forms" are often needed but hard to create geometric elements. In many cases, you
can use these elements as a construction aid. For example, you can use a regular polygon to
place connection points in a circular area. Just create a regular polygon and place a connection
points on every edge of the polygon. Now you can delete the polygon, and your connection points
are perfect placed.
 
There are 4 special forms available:
 

Regular polygon
Star
Table
Sine curve

 

 To create a special form, select the special form mode from the mode section.
 

 
Select the desired form in the tab bar on the top of the dialog. Every form has special properties,
which you have to set in this dialog.
 
After you have confirmed this dialog, you can draw the selected form. Click on the start position
of the form and hold the mouse button down. Move the mouse to the end position (bottom right)
and release the mouse button. The form is now created, and you can go on with another one.
 
You can press the CTRL-key while you are drawing a form to force an exact square form outline.
 
The special forms will always be created with the currently selected preferences .
 
The forms Polygon and Star can be created either as a line or as a polygon. If the form should
receive a brush, you have to select the option "as polygon" .



How to draw lines
 

 Select the LINE mode from the mode section.
 
The first click marks the start point of the line. Click again at another position to mark the next
point, and so on.
 
If you have finished the line press the right mouse button. You can now start with another line.
Press the right mouse button again, to return to the default edit mode.
 
When you have finished drawing lines, return to default edit mode (arrow), to change its size or
properties. Use the changer to move the nodes of the lines. You can even add or delete nodes
from your line. Click with the right mouse button on a changer to add a new node or to delete a
node. You can also split a line into 2 single lines.
 
The line's angle is captured to a certain value, which is displayed in the status bar.
 

 
Click on the display to select another value. To turn off the angle capture temporary hold down
the CTRL-key of your keyboard.
 
The line will always be created with the currently selected preferences .
 
With a doubleclick on the polygon you can edit its properties like color, style, etc.



How to draw bezier curves
 
Bezier curves are special curves with a start point, 2 control points and an end point. The curve
always starts in the start point and ends in the end point. The 2 control points are controlling the
form of the curve.
 

 
A simple bezier curve consists of exact 4 points. You can also define more curves in one bezier
line. In this case, the end point of the last curve is also the start point of the next curve, so it will
take 3 points for every additional curve (2 control points and 1 end point). Therefore a bezier
curve consists at least of 4 points, and 3 points for every additional curve, so altogether either
4,7,10,13,... or more points.
 

 To draw a bezier curve select the BEZIER mode from the mode section.
 
The first click marks the start point of the curve. Click again to set the first and the second control
point and at least the end point of the curve. For an additional curve you can now click again to
set next 2 control points and the end point. To finish drawing just click with the right mouse
button. You can now start with a new bezier curve. Press the right mouse button again, to return
to the default edit mode.
 
While you set the 2 control points of a curve, the curve can not being displayed, because the final
form of the curve depends on the end point. But don't take this to heart, you can move the
control points later to define the form of your curve exactly.
 
When you have finished drawing bezier curves, return to default edit mode (arrow), to change its
size or properties. Use the changer to move the nodes of the curve.
 
The bezier curve will always be created with the currently selected preferences .
 
With a doubleclick on the bezier curve you can edit its properties like color, style, etc. 



How to mark connections
 
Crossing lines can be marked with a point.
 

 Select the CONNECTION mode from the mode section.
 
Click to the positions, that you want to be marked as a connection.
 
When finished press the right mouse button, to return to default edit mode.



How to add text labels
 

 Select the TEXT mode from the mode section.
 
Click to the position, where you want the text to be created. The label property dialog opens.
 

 
You can now enter the text and the text height in steps of 1/10 mm. Press the FONT-Button to
select a font for the label. You can also determine if the text should be right aligned. If a text is
right aligned, and the text changes, the right end of the text will be fixed.
 
With the button '...' you can call an extended text dialog. Here you can insert variables and text
constants. For more information see also Variables and text constants .
 
Within the "Link"-section you can define active links to another text labels. For more information
see also Active links .
 
Close the dialog with OK to create the label. You can now click again to create another label or
use the right mouse button to return to default edit mode.
 
With a doubleclick on a label, you can call this dialog again to change any settings.
 
If you select a label, you can change its size, form or direction with the sizer .



How to create TextRects
 

 Select the corresponding mode from the mode section.
 
Click to the top left corner of the textrect, hold the mouse button down and draw a text rectangle
and release the mouse button. The following dialog will appear:
 

 
Enter the text to the edit field. Press the FONT button to select a font. Text height and alignment
are adjustable. Press OK to create the textrect. A double click on a textrect opens the dialog again
for changes.
 
The textrect will always have an outline on the screen. This broken line will not appear on any
printout or export. If your text will overlap this outline, it will be clipped. The outline defines the
maximum size  of the textrect.
 
If you select a textrect, you can change its size, form or direction with the sizer .



How to import bitmaps
 

 Select the corresponding mode from the mode section.
 
Click to the diagram to determine the position of the bitmap. Select a bitmap file from the file
dialog. The bitmap will now appear in your diagram.
 
sPlan supports the BMP and the JPG format. If you need to import graphics in another format, you
have to convert these graphics into BMP or JPG format.
 
If you select a bitmap, you can change its size, form or direction with the sizer .



Element properties
 
You can change the properties of each element, with a double click on the element, to open its
property dialog. You can also select the PROPERTIES item from the local popup menu ( right
mouse button on the element).
 
Certain objects have certain properties:
 

For rectangles, circles and polygons the dialog "Pen and brush" opens.
For lines and bezier curves the dialog "Line properties" opens.
For labels the dialog "Text properties" opens.
For textrects the dialog "TextRect" opens.
For components and symbols the dialog "Component properties" .



Pen and brush properties
 

 
Here you can select the properties of the pen and the brush of closed elements.
You can define the pen width and color for the outline, or select no outline .
You can define the brush color and style for the element, or select no fill .
In the preview section you can always see the effect of your changes.
With the default button you can set the pen and the brush to the default settings.



Line properties
 

 
Here you can select the properties of a line.
 
At the top of the dialog you can set the line style (solid, dash, dot, ...). The symbols left and right
beneath the line style defines the start and end style of the line. You can select several symbols
like arrow, diamond, etc.
 
You can set the pen width in steps of 1/10 mm.
 
The arrow size determines the size of the start and end styles of the line. You can select between
small, medium and large.
 
You can define the color of the line.
Activate the 2 nd color to get striped lines with two colors. The line style defines how the line will
be striped.
 
The displayed line always shows the effect of your changes.
 
With the default button you can set the line to the default setting.



Text properties
 

 
Here you can enter the text and the text height in steps of 1/10 mm. Press the FONT-Button to
select a font for the label. You can also determine if the text should be right aligned. If a text is
right aligned, and the text changes, the right end of the text will be fixed.
 
With the button '...' you can call an extended text dialog. Here you can insert variables and text
constants. For more information see also Variables and text constants .
 
Within the "Link"-section you can define active links to another text labels. For more information
see also Active links .



TextRect properties
 

 
Enter the text to the input field.
You can set the alignment of the text. The text will be aligned within the text frame.
You can also set the text height, and select a new font.



Component properties
 

 
Identifier
The identifier consists of a character, followed by a number (e.g. R1). You can enter an identifier
for each individual component, or enable the very useful option automatic numbering .
 
Automatic numbering
If you want to use the automatic numbering option, simply enter a character like "R" (without
number!) to the field identifier and activate the option AUTOMATIC NUMBERING. The software will
find all components with identifier "R" and number them automatically.
 
After you have deleted components from the diagram, some numbers may miss. In that case you
can call Renumber components...   from the Functions menu item, or from the toolbar.
 
Identifier visible
Disable this option for some symbols, which don't need an identifier displayed (like arrows, etc).
 
Type/value
Use this field to enter a components type or value, like "1k" for a resistor, or "BC547" for a
transistor.
 
Request type/value
The option REQUEST TYPE/VALUE enables the data request, when the component is dragged and
dropped to the diagram. Use this option for components, that need type or value information,
which you don't know, when the component is being designed. You can also use this feature, to
confirm a predefined default value.
 
Type/value visible
Disable this option if a component has no type or value, or if you don't want to display it for some
reasons.



 
Add to components list
If this option is selected, the component will appear in the component list. Disable this option for
simple symbols like arrows, which should not appear in the component list.
 
Description
If you like, enter a short description to this field, which will be displayed beyond the component in
the library. Use short text to keep the library small!
 
Editor
Press this button to activate the component editor .
 
Contacts
Components can be equipped with so-called contacts , which are editable pin descriptions. They
allow to change descriptions easily without opening the component editor.
If the component includes contacts, you can extend the dialog, and the contact list is shown. Here
you can edit the pin descriptions of the component contacts.



The clipboard
 
The clipboard functions are well known from almost all Windows applications:
 

Cut
Copy
Paste
Duplicate

 
Clipboard functions are called from the EDIT item in the main menu, from the toolbar, or from the
local popup menu.
 
Cut
This function copies all selected objects to the clipboard and deletes all selected objects from the
diagram.
 
Copy
This function copies all selected objects to the clipboard. Selected objects will remain in the
diagram.
 
Paste
This function adds the contents of the clipboard to the diagram. The objects will "stick" on the
mouse cursor, and you can place it with a click.
 
Duplicate
This function performs COPY and PASTE in one step.



Zoom
 

 Select the ZOOM mode (magnification glass) from the mode section.
 
You can now increase magnification, clicking with the left mouse button to the diagram. The right
mouse button decreases magnification. You can also frame the area you want to zoom to.
 
Three additional zoom functions are available from the toolbar:
 

Zoom page
Zoom elements
Zoom selected elements

 
You can also zoom with your mouse wheel. move your mouse to the place on your diagram you
want to zoom, keep the CTRL-key pressed and roll your mouse wheel.



Rotating, mirroring and arranging objects
 
All elements can be easily rotated, mirrored and arranged.
The following functions are available:
 

Rotate
Mirror (horizontal)
Mirror (vertical)
Set to front
Set to back

 
The functions are available in the Functions menu, from the toolbar or from the local popup
menu. To perform one of these functions, first select the objects and then call the function.
 
Rotate
With the rotate-button in the toolbar you can rotate selected elements 90° clockwise.
With the "Rotate..." entry in the "Function" menu all selected elements will be rotated clockwise
with an editable angle. You can hold down the SHIFT-key on your keyboard to keep text objects
in readable position, while rotating objects.
You can rotate selected elements also with your mouse (see sizer and changer ).
 
Mirror
All selected objects will be mirrored along the vertical or horizontal axis. Text objects won't be
mirrored, this will keep the text readable. You can hold down the SHIFT-key on your keyboard
while mirroring, to force that text elements will be mirrored too.
 
 
To front / to back
These functions will change the z-order of the selected objects. The effect of these functions can
only be seen, if two or more objects were overlapped. Use Set to front to make an object lay on
top of all others, use Set to back to have it overlapped from all other objects.



Adjusting elements
 
With this function you can adjust elements to each other.
First you have to select all elements, that should be adjusted. Then select the ADJUST button
from the toolbar and select the direction of adjustment. The following adjustments are available:
 

Top
Bottom
Left
Right
Horizontal
Vertical

 
Note that you have to select at least 2 elements, to call the ADJUST function.



Coloring elements
 
Use this function to change the color of all selected elements at once, instead of calling the
property dialog for each individual object.
 
Select the objects that have to be changed and call the Colorize elements... function from the
Function menu. A color dialog allows you to select a new color. You will not see the effect while
objects are still selected (magenta). All lines and fillings will appear in the new color, except
objects that have a white filling. The white filling is reserved for components, which often contain
text objects like descriptors, which should always be readable.



Build and split groups
 
Building groups
Objects can be combined to groups, to make them selectable with one single click. Groups also
protect their elements against unwanted changes in positions, color, etc. Members of a group can
not be deleted separately. You need at least two elements to build a group and a group can
contain one or more sub-groups. To build a group select the elements and call Functions ->
Build group from the main menu or from the corresponding button in the toolbar.
 
Splitting groups
If you wish to edit a group member separately you have to split the group. Select the group and
call Functions -> Split group . If the group contains subgroups, these will stay unaffected. You
may repeat this action with the subgroup.



Magnetic lines
 
Magnetic lines are used as a construction aid, so they have no style properties and will not be
printed. They are helpful to find the correct position when objects are moved. Elements are
adjusted to magnetic lines automatically, when an element is moved near to a magnetic line.
 
Adding magnetic lines
An easy way to create a new magnetic line is to draw it from the ruler. Just click on a ruler, keep
the mouse button pressed and move the mouse on your diagram. If you release the mouse
button, the magnetic line will be created.
 
You can also select New magnetic line vertical or New magnetic line horizontal from the
Functions->Magnetic lines submenu. The new line will appear in the diagram.
 
 
Moving magnetic lines
Move the mouse above a magnetic line. The cursor will show that you can move the line. Click to
the magnetic line and move it to the new position, while holding down the left mouse button.
 
Deleting magnetic lines
Click to the magnetic line. The line will change its color to red. Now select Delete from the main
menu or from the toolbar or press the DEL-key.
 
An easier way to delete a magnetic line is to draw it back to the ruler. Just click on a magnetic
line, keep the mouse button pressed and move the magnetic line to a ruler. If you release the
mouse button, the magnetic line will be deleted.
 
Fix magnetic lines
You can call this function from the Functions->Magnetic lines submenu to fix all magnetic lines
on your page. This will protect all magnetic lines against moving or deleting. In this mode, it is
also not allowed to add new magnetic lines to your page. You can always leave the fixed mode if
you select this function again.
 
Hide magnetic lines
You can call this function from the Functions->Magnetic lines submenu to hide all magnetic
lines on your page. In this mode, it is also not allowed to add new magnetic lines to your page.
You can display your magnetic lines if you select this function again.



Using forms
 
Every page can have its own background form. The form is a separate layer, which lies under the
true diagram. Normally, the form is only visible, but you can't select or edit any elements from
the form. The advantage is that elements from the form do not disturb your work, when editing
the circuit.
You can create your own forms, or edit existing forms just like you want.
 
How to create a user defined form
If you want to edit the form of the current page, you have to open the form for editing. Select the
function Edit form from the menu Forms . The diagram will now hide, and the form is open for
editing. Now you can edit the form with all drawing features of sPlan.
 
If you have finished, you have to deactivate the function Edit form , just click on the same menu
entry. Now the form will be set to back and your diagram is shown again.
 
How to save forms to file
A form that once has been drawn can be saved to a file, so that the form can be used whenever
needed for another pages. Call Save form to file... from the Forms menu. Files that contain a
form, have the extension *.SBK.
 
How to load forms from a file
You can load existing forms to the current page. Call the Load from file... function from the
Forms menu and select a file with the extension *.SBK. Note that any existing form on the
current page gets lost, if you load a new form.



Operate with several pages
 
A circuit diagram that is drawn with sPlan can consists of several pages. Large projects should be
split to smaller modules, so that every module has its own page in the document. For example
the circuit diagram of a power amplifier, can be divided into the following modules:
 
Power amp = Supply + Preamp + Sound control + Main stage
 
The diagrams of the four modules can be drawn on individual pages, and all together can be
saved to a single file called "POWERAMP.SPL" for example.
 
You can add as many pages to a project as you like, and give them an individual name. On
bottom of the editor you find a register with an entry for every page that exists in the project.
Click on one of these entries to activate the page.
 
You can get a local context menu, if you press the right mouse button on the page register. Here
you will find functions to load and save pages to files, or to change the order of pages.
 
Page properties
Use the menu item Page properties from the Page menu or the local popup menu, to change
the properties of the paper sheet.
The dialog allows you to adjust the paper format and the orientation and you can enter a name
for the page (see also Page properties ).
 
Creating new pages
Call Create new page... from the Page menu or the local popup menu. A new, empty page will
be added to your project. The new page is named "PAGE x". To edit the page properties call Page
properties .
 
Copying pages
Use the Copy page... command from the Page menu or the local popup menu to make a copy of
the current page.
 
Deleting pages
Call Delete page... from the Page menu or the local popup menu to delete the current page from
your project. You will be asked to confirm the deletion.
 
A project must at least contain one page. You can not delete a page, if the page is the one and
only in your project.
 
Moving pages
There are two functions to change the order of pages in the page register.
 

Move page to left
Move page to right
Move page one to the left
Move page one to the right

 
You can call these functions from the Page menu or the local popup menu to sort the pages of
your project.
 
Saving pages
This feature was designed for exchanging single pages with other projects. Call Save page...



from the Page menu to save the current page to a file. Single pages have the extension *.BLT.
 
Loading pages
You can load existing single pages. Call Load page... from the Page menu to add the page to
your project.



Line and fill preferences
 
If you prefer certain styles for lines or fillings, these parameters can be set previously, and were
used for all drawing operations. Click to the corresponding buttons in the status bar to change the
preferences for lines and fillings.
 

 
A dialog will open that lets you change the parameters.



Symbols and components
 
Symbols and components are the most important parts of a circuit diagram. On the left of the
main window you find the component library , that contains symbols, components and parts on
several pages. You can add new pages, add components, exchange components, and so on, to
customize the library.
 
The library pages are listed in alphabetic order in the combo box on top of the library. Use this list
to open a page of the library.
 
The components can easily dragged & dropped to your diagram.



What is a component?
 
Components are special groups of the basic elements like circles, rectangles, etc. Basically the
component component "resistor" consists of a rectangle, with two lines, representing the wires.
When these elements become a component, the following happens:
 

2 new labels will be added (Identifier and Type/Value)
a group is built from these elements

 
For example, the identifier can contain "R1" and the field can be set to "1k" for a 1-kOhm-
resistor. This is the same with all components that you will find in the library.
 
sPlan offers some additional features, to make the handling with components more  easy and
comfortable:
 

The label for the identifier can be hidden, if not necessary
The label for type/value can be hidden, if not necessary
You can use an automatic numbering option for the identifier
You can enable a request for type/value, when the component is added to the diagram
You can determine if components will appear in the components list or not
You can enter a description, which is displayed under the components in the library.
You can enter a comment, which is displayed in the component list.

 
Equipped with these features, sPlan offers various possibilities for your own creation of
components. A component must not be a component in a electronically way. You can define
symbols, or any other parts as a component too. At least you could use sPlan for something
completely different, but circuit diagrams!



Editing components
 
You can apply changes to every component, independent whether it is in the library or in your
diagram. If you want to make general changes, you better edit the component from the library.
The library component is like a parent to all components that are added to the diagram. Its
properties will be copied from the library component, when it is dragged & dropped to the
diagram. On the other hand, you should edit the component in the diagram, when changes are
individual to this element. So the original component in the library will stay unaffected.
 
Double click on a component to open its property dialog and to make some of the following
changes:
 

 
Identifier
The identifier consists of a character, followed by a number (e.g. R1). You can enter an identifier
for each individual component, or enable the very useful option automatic numbering .
 
Automatic numbering
If you want to use the automatic numbering option, simply enter a character like "R" (without
number!) to the field identifier and activate the option AUTOMATIC NUMBERING. The software will
find all components with identifier "R" and number them automatically.
 
After you have deleted components from the diagram, some numbers may miss. In that case you
can call Renumber components... from the Functions menu item, or from the toolbar.
 
Identifier visible
Disable this option for some components, which don't need an identifier displayed (like arrows,
etc).
 
Type/value
Use this field to enter a components type or value, like "1k" for a resistor, or "BC547" for a



transistor.
 
Request type/value
The option REQUEST TYPE/VALUE enables the data request, when the component is dragged and
dropped to the diagram. Use this option for components, that need type or value information,
which you don't know, when the component is being designed. You can also use this feature, to
confirm a predefined default value.
 
Type/value visible
Disable this option if a component has no type or value, or if you don't want to display it for some
reasons.
 
Add to components list
If this option is selected, the component will appear in the component list. Disable this option for
simple symbols like arrows, which should not appear in the component list.
 
Description
If you like, enter a short description to this field, which will be displayed beyond the component in
the library. Use short text to keep the library small!
 
Editor
Press this button to activate the component editor .
 
Contacts
Components can be equipped with so-called contacts , which are editable pin descriptions. They
allow to change descriptions easily without opening the component editor.
If the component includes contacts, you can extend the dialog, and the contact list is shown. Here
you can edit the pin descriptions of the component contacts.



The component editor
 
the handling of the component editor is almost the same as the main editor for the circuit
diagram. It is equipped with all functions you will need to draw a symbol or component.
The component data (Identifier, Type/Value) is displayed as [ID] and [VALUE]. You can move
these labels to any position you like. You can double click them, to change the properties like font,
color and height. The text of these labels can not be changed, because it is reserved for the
component data as a wildcard. You can not delete these labels, but you have already learned how
to hide them, when calling the property dialog for a component .
 
Contacts may be used for components with variable pin descriptions.
 
 
There is one very important thing you'll have to deal with... The red point!
 
The red point
You have already heard about the grid, when editing a circuit diagram. The red point defines the
position of the component to the grid. The red point will always fit to the grid, when the
component is added to the diagram, no matter what the component looks like. So the positioning
of the red point is very important, to make the component connectable within the circuit
diagrams.
 
Setting the red point is a simple as important. Move the red point to one significant point of the
component that you have drawn. For components that have connections, move to red point
exactly to one of the connections. The best way to do is to use the grid of the component editor.
Set one connection and the red point exactly to a grid point.
 



How to create your own components and symbols
 
There are a few possibilities to create own components. The first decision you should make is,
whether the new component must be drawn completely new, or to create it from an existing
component, that is similar to the one you need.
 
Creating a new component
Select Create new component... from the Library menu item. The property dialog will open.
Enter the components properties and the click the Editor button to open the component editor. A
component must at least consists of one drawing element, so we use a square with 20-mm edges
as default.
You may now delete this square and draw the component you want. When finished close the
component editor and the property dialog. Your new component will now appear in the library, on
the bottom of the current page.
 
Creating a component from an existing component
First choose a component, that is similar to the one you want, and add it to the circuit diagram.
Now you can edit the component. Double click to the component and call the component editor,
as you learned before.
When you have finished, close the component editor and the property dialog. You will now see the
changes you have made to the component in the circuit diagram.
All that is left to do is to copy the component from the diagram to the current library page.
Therefore you will find the item Add Component(s) to library in the Components menu. Again
the component will appear on bottom of the current libraries page.
 
Last but not least there is another way to create a component. This is done, by selecting objects
from the circuit diagram, and calling the function Create component from selection... from the
Components menu. The property dialog will open. Enter the component data or make additional
changes with the component editor, if you like. When closing the dialog, again the component will
be added to the bottom of the current library page.



Contacts
 
Another special feature of the component editor allows you to add so-called "contacts" to a
component. A contact is like a label, where the text of the label is easily editable in the
components property dialog. You don't have to call the component editor to edit these contacts.
 
Usually you will use contacts to describe component pins. Certainly you can do this with ordinary
labels, but some components look exactly the same, while only the connections of the
components have different names. In that case contacts can be useful to have a component only
once in a library and pin descriptions can be entered later, when the component is "built-in" to the
circuit.
 

 Select the corresponding button from the toolbar of the component editor, to add a contact to
your component.
 
The contact will now "stick" on your mouse, and you can place it with a mouse click.
 
A double click on the contact opens the following contact dialog:
 

 
Name
Enter a name for the contact. This name is used to identify the contact, when the text is edited in
the component property dialog.
 
Text
Enter a text for the contact. This text is displayed with the component in the diagram and can
later be edited in the component property dialog .
 
With the button '...' you can call an extended text dialog. Here you can insert variables and text
constants. For more information see also Variables and text constants.
 
Font
Click to this button to define the text font and text height of the contact.
 
 

Creating a contact list
You can create a contact list, which contains all contacts together with there inscriptions and the
components which belongs to them. To create the contact list call the entry Create contact
list... from the Function menu.
 
 



Splitting components
 
A component can be splitted into the elements the component consists of. Doing this, the special
component data will be lost.
 
To split a component, select the component to be splitted. Then select Components -> Split
component from the main menu.



Change component inscriptions
 
If you want to change the font, the color or the size of several or of all components, you can call
the following dialog with Components -> Inscription.. from the main menu.
 

 
In this dialog you can edit the text height and font for the identifier and for the value. The section
Apply to let's you select which components should be changed. If you confirm this dialog, the
changes will be made immediately.



The component library
 
Components are the most important parts of a circuit diagram. On the left of the main window
you find the component library, that contains symbols, components and parts on several pages.
sPlan offers several functions to customize the library:

Adding new pages
Renaming pages
Deleting pages
Deleting components
Move components within a page
Move components from one page to another
Adding additional libraries

 
The library pages are listed in the combo box in alphabetic order on top of the library. Open the
list and click to an entry to open a certain page from the library. You can drag & drop the
components from the library to your diagram.
 
If you move the mouse cursor to the library, the background of the selected  component darkens,
to mark the component. Some of the library functions, like DELETE, refer to the selected
component.
 
Press the right mouse button, while the cursor is in the library, to open a local menu, which offers
some often needed library functions.



Display options of the library
 
Some display options are available for the library. You can determine the number of columns that
are filled with components or turn off the display of component names. These options are
available with a click to the buttons on bottom of the library.
 

 
The buttons "+" and "–" increase and decrease the number of columns. Right from that you find a
button that turns the component descriptions on and off. While component descriptions are
turned off, you can move the mouse cursor to a component. The description is then being
displayed as a popup hint. This setting is useful for large libraries with many components.
 
The width of the library is adjustable. Move the mouse cursor to the right border of the library.
The cursor will appear as a double arrow. Hold down to mouse button and move the mouse, to
adjust the width of the library.



Editing a library page
 
Use the following functions to customize the library:
 
How to create a new page for the library
Execute Create new library page... from the Library item of the main menu. You will be asked
to enter a name for the new page. The library pages are sorted in alphabetical order, so the name
determines the position of the entry in the listbox.
 
How to rename a page of the library
Execute Rename library page... from the Library item of the main menu. You will be asked to
enter a new name for the current page. The library pages are sorted in alphabetical order, so the
name determines the position of the entry in the listbox.
 
How to delete a page from the library
To delete a page with all its components from the library, execute Delete library page... from
the Library menu. You will be asked to confirm the DELETE command. If you confirm with OK the
library page and its components will be gone forever.
 
This command, like some others, can also be called from the local popup menu of the library,
which opens if you click the right mouse button over the library.
 
How to move components within a page
You can change a component position on a library page, using the following commands:
 

Move up
Move down
To top
To bottom

 
These commands refer to the selected component in the library, and can be used to sort the
components of a library page. You can call these commands from the Library menu, or from the
local popup menu of the library, that opens if you click the right mouse button over the library.
 
Tip:
You can also drag & drop a component to another position in the library.
 
How to exchange components between library pages
To move or copy components to another library page do this:
 

select the library's source page and add one or more components to the diagram
select the components, that you have added to the diagram
select the library destination page
execute Add component(s) to library from the Components menu

 
All selected components will now appear in its destination page. Delete the source components, if
you like.



The file-structure of the library
 
With sPlan you can work with several libraries, each with several pages. A library is stored in a
certain directory on your hard disk. Each page of this library is stored as a file (*.lib) in this
directory.
 
2 libraries are installed together with the program:
 
Standard
This is the default library, which is installed in the \BIBO directory in the installation path of your
software.
 
User
This library was made by sPlan users and can be found in the \USER subdirectory of the BIBO
directory.
 
Both directories contain several files. Each file contains the data of a library page. A new file is
created when a new page is added to a library. The filename is LIBx.LIB, where x stand for a
serial number.
 
The command Library page information... is available from the Library item in the main menu.
It gives you information about a certain library page and displays the directory and the filename,
where the library file is stored.



Selecting a new library
 
With sPlan you can work with several libraries. Maybe you have one library with electronic parts,
and another library with hydraulics parts. After the installation of sPlan there will be already 2
different libraries installed (Standard and User).
 
To change from one library to another, click to the library button (book) on bottom of the library.
 

 
The following library dialog opens:
 

 
The left list contains all installed libraries. Select an entry and click to the SELECT button or
double click the entry. The new library is now activated.



Creating new libraries
 
There are different reasons, why you should create a new library:
 

Libraries may become too large to be clear
Components from various themes are used with sPlan
You want to share libraries on a network

 
The first thing to do is, to create a new directory (folder) anywhere on your system (or network).
Therefore use the Windows Explorer. You may now copy library files (*.LIB) to this directory or
leave the directory empty.
 
You can now use the new directory as a sPlan library. Click to the library button (book) on bottom
of the library:
 

 
The following dialog opens:
 

 
Click to the new button. A new entry is added to the list. Now click on the browse button (...) and
locate the new library directory, which you have created before.
 
Important:
The browse dialog shows files as well as directories. Make sure that you only select directories. Do
NOT select files!
 
After locating the library directory path, you can enter a clear name for the library to the edit field
below the path. You can now use your new library as any other library.



How to rename and delete libraries
 
With sPlan you can work with several libraries. To rename or delete a library, click to the library
button (book) on bottom of the library.
 

 
The following library dialog opens:
 

 
Select an entry of the library list. You can now select another path (browse button "...") for the
library or enter a new name for the library.
 
To remove an entry from the library list, click on the delete button. You have to confirm this
operation. Only the entry of the library list will be deleted. The library itself will remain unaffected.
So you can add the library again, if necessary.



Library administration
 
sPlan offers an integrated library administration, which makes it easy to move, copy or delete
pages of libraries.  Click to the library button (book) on bottom of the library.
 

 
The following library dialog opens:
 

 
Click on the "Manage..." button to open the library manager:
 

 
You can now exchange library pages between two libraries. Select two libraries (for example:
USER and STANDARD) from the list box on top of both lists. The lists show all pages, contained in
the libraries.
 
You can now select list entries (pages) and move or copy them to the other library. Press the
DELETE button to delete a page from a library (immediately!).



Rename, import and backup of library files
 
How to rename library files
Library files (pages) use the file extension *.LIB. You can simply browse and rename these files
using the Windows Explorer. This will make sense if you want to distribute a library page. A name
like TUBES.LIB is much clearer than LIB12.LIB. Make sure that you keep the file extension .LIB
when renaming library files.
 
Import of library files
If you received a new library file from a colleague or from our homepage www.abacom-online.de ,
you can copy the library files (*.lib) to any library directory. Take care not to overwrite existing
files! If a file already exists in your library, you will have to rename this file before copying. In
some cases libraries are published as circuit diagrams (*.SPL) on the Internet. In that case you
have to open the diagram and add the contained components to your library manually.
 
Backup of libraries
To create a backup of your libraries, simply make a copy of all library directories and the included
*.LIB files. If you have to reinstall sPlan, you can restore your libraries from the backup files. If
you had created your own libraries, you will have to register these libraries to sPlan again (See "
Creating new libraries " ).



Variables and text constants

What are variables and text constants
 
Usage of variables and text constants
 
Definition of text constants
 
Definition of variables



What are variables and text constants
 
You can use text constants and variables instead of static text within the text labels in sPlan.
 
Text constants
Text constants are saved text blocks, which are available at any time. If your diagrams contains
often needed phrases, you can save these phrases as text constants. Any time you have to enter
these phrase, you can call the text constant. So you don't have to type in the phrase.
 
Variables
Variables are an extended form of text constants. Every variable has a NAME and a TEXT
CONTENT. The name is a wildcard for the text content, and is always framed between the
characters "<" and ">". For example a variable name can looks like <PROJECTNAME> .
 
On your diagram, not the variable name will appear but their text content. If you have assigned
the text "Amplifier Project 54X-922" to the variable <PROJECTNAME> , a label with the
content <PROJECTNAME> will be displayed as "Amplifier Project 54X-922" . If you change
the text content of this variable, the displayed text on your diagram will change immediately,
everywhere in your project.
 
There are 2 kinds of variables in sPlan: The predefined variables and the user variables . The
predefined variables are always and everywhere available. The user variables can be defined by
the user within a project, and they are available only in the project where they are defined.
 
The predefined variables are:
 
<TIME>
The current time
 
<DATE>
The current date
 
<PAGENO>
The current page number
 
<PAGECOUNT>
The count of pages in the current project
 
<PAGENAME>
The name of the current page
 
<FILENAME>
The name of the file (only if saved)
 
<FILEPATH>
The path of the file (only if saved)
 
<VERSION>
The current version of sPlan
 
The predefined variables can be used just like the user defined variables. You can also mix the
variables with static text. For example a label with the text:
 
"This is page <PAGENO> of <PAGECOUNT>"
 



will be displayed on the diagram as:
 
"This is page 2 of 4"
 
(provided that this label is on page 2 of total 4 pages)
If you copy this label to another page, or the total number of pages changes, the displayed text
will change immediately.
 



Usage of variables and text constants
 
Whenever you can edit a text label in sPlan, you can also extend this text with variables and text
constants . On the right on these edit fields exists a "..." button:
 

 
With this button you can call an extended text dialog, which makes it easy to insert variables and
text constants.
 

 
To insert a variable or a text constant just click on the corresponding button. A list of available
entries will be displayed, and you can simply select the entry you want. The variable or text
constant will be inserted at the current cursor position in the edit field.
 
Of course, you can type in the text manually, but with this dialog it is much easier.
 
With the 2 buttons Define... you can define or edit user variables or text constants.



Definition of text constants
 
You can define as many text constants as you want. To define text constants call Edit text
constants... from the Options item of the main menu. If you have the extended text dialog
open, you can also click on the corresponding Define... button.
 

 
In this dialog you can edit, delete or extend your text constants.



Definition of variables
 
You can define as many user variables as you want. To define user variables call Edit user
variables... from the Options item of the main menu. If you have the extended text dialog open,
you can also click on the corresponding Define... button.
 

 
In this dialog you can edit, delete or extend your variables.
Every variable has a NAME and a TEXT CONTENT. The name is not case sensitive.
 
If you change the text content of a variable later, all labels which use this variable will be changed
automatically.



Automatic component numbering
 
Components in circuit diagrams are usually named with numbered identifiers, like R1,R2, R3 and
so on. sPlan can do this automatically for you, if you want.
 
You can enable or disable this option for every component individually. Double click to a
component, to open its property dialog.
 
If you want to use the automatic numbering option (let's say for a resistor), simply enter a
character like "R" (without number!) to the field IDENTIFIER and activate the option AUTOMATIC
NUMBERING. The software will find all components with the identifier "R" and number them
automatically.
 
We suggest to make changes like that to the components in the library, so that all copies get the
same properties, when you drag & drop them to the diagram.
 
The software will NOT renumber your parts, if you delete components from the diagram. In that
case you can call Renumber components... from the Functions menu (or from the
corresponding button in the toolbar).
 

 
Here you can select the pages, that should be included in the automatic renumbering.
 



 
Here you can select if you want a geometric sort or not.
 
Sort option: None
Components are numbered in the order you have added them to the circuit.
 
Sort option: Columns
The numbering function starts with the first column, searches components downwards and
continues with the next columns.
 
Sort option: Rows
The numbering function starts with the first row, searches components rightwards and continues
with the next row.
 
Geometrical grid
This parameter determines a square, which is used for the component search in rows or columns.
Renumbering start with all components in the first square at the top left position of your diagram.
Then the square is moved along the row or column, and so on. Depending on the square size, to
result of the renumbering can be different.



Component lists
 
An important function of sPlan is the creation of component lists.
Component lists can be created automatically. After creation you can edit, print, save and load
them. Call Create component list... from the Functions menu, or click on the corresponding
button in the toolbar.
 

 
You can select one or more pages that are considered for the component list:
 



 
The list will appear in its own text editor, so you can make changes if you like. You first have to
close the components list editor, before you can continue your work on the circuit diagram.
 
There are some useful options when creating components lists:
 
Collect equal values
This option can be useful, to shorten a list which contains lots of identical parts.
 
      R1      = 1k
      R2      = 1k
      R3      = 1k
 
...will become...
 
      R1,R2,R3      = 3 x 1k
 
Caution:
The list will be recreated, when you activate this option, and your changes will be overwritten.
 
File data
Use this option to display additional information in the component list:
 

Time and date
File path and name of the project file
Page name



 
Caution:
The list will be recreated, when you activate this option, and your changes will be overwritten.
 
Sort option: Quantity
The components that are used most will appear on top of the list.
 
Sort option: Alphabetical
The components will appear in alphabetic order.
 
Print
Click to the button PRINT to get a printout of the component list. Feel free to adjust left and right
border before.
 
Copy
Click the COPY button the copy the components list to the Windows clipboard. After that, you can
paste the data into other applications.
 
Save
The component list can be saved to a file, using Rich Text Format (*.RTF), which can be used with
most text editors.
 
Open
Use this to load a previously saved component list into the editor. (Do NOT use FILE->OPEN from
the main menu, this is for diagrams only! )
 
Export
You can export the component list. Exported component lists can be imported from other
programs like EXCEL.
 
Close
Click CLOSE to continue your work on the circuit diagram and to close the components list editor.



Component search
 
sPlan offers a special search function for components. This function is useful with large projects
that are spread to several pages. Components can be searched, using their identifiers and values.
The function can be called with Search components... from the Edit menu or from the
corresponding button in the toolbar.
 

 
Identifier
A filter can be set to find components with certain identifiers:

Leave this field empty to list all components.
Type e.g. "R" to find all components with a "R" in its identifier (R1, R8, R12, etc.)
The filter "R1" will find all components with R1 in the identifier (R1, R11, R12, etc.)

 
Type / Value
A filter can be set to find components of certain types or with certain values:

Leave this field empty to list all components.
With this filter set to "6" all components with a "6" in the type/value field will be listed
(0,68µF, 16k, etc.).
With this filter set to "0,68" all components with a "0,68" in the type/value field will be listed
(0,68µF, etc.)

 
Both filters can be combined.
 
All pages
Select this option to search components on all pages. Otherwise components are searched on the
current page only.
 
Start search
This will start the searching progress. The list will be filled with all components that match with



the filters.
 
You can double click to the identifier field of the list, to select and show the component in the
diagram.
 
Tip:
The type/value field of the list is editable. This is an efficient way to enter values for your
components.



Active links
 
You can create active links from one place on your diagram to another place. It doesn't matter, if
the link is on the same page or on another page. You can follow the links with a simple mouse
click, so you are able to create interactive circuit diagrams.
 
An active link is always bound to a label. You can create links from one label to another.
 
The link will be created in the property dialog of a label. Call this dialog with a double click on a
label.
 

 
In the bottom of this dialog you can see the section "Link" .
 
With the option "Available as target" you can define this label as a link target for other labels.
 
With the "Select target" button you can define a target. If you click this button, a list of all
available targets will be displayed. Just select the target you want. If there is no label available as
target, the list is empty.
 
The text "Target:" shows the current selected target. If you want to delete this target, just click
on the button "Select target" and select another target or select "Delete Link" from the
displayed list.
 
All targets will be named with the text of its label. So you have to pay attention to the following 2
points:
 

Take care of the target labels text. Please don't use the same text for more than one target
label to avoid confusion.
If you have to change the text of a target label, please adapt all labels that use this link as a
target. Otherwise, the target won't be found anymore.

 
 
Labels with active links will be marked automatically:
 



 
All labels which are available as target get an inner arrow on the left side.
All labels which are active links (which has a target) get an outer arrow on the right side.
So you can always see, which labels are active links or targets.
 
Follow an active link
To Follow an active link, just click with the right mouse button on the label and select Follow
link... You can also follow a link with the F8 -Key. You have to select the link label first.
The link will be located, selected and displayed in the center of the screen.
 
Creating a link list
sPlan offers the possibility to create a link list. This list contains all active links together with their
text lables and pages. To create a link list choose Create link list... of the Function menu.
 
Internet link
You can even create a link to the internet. All you have to do is to enter a label text which starts
with "www.". If you enter e.g. "www.abacom-online.de" in a label, sPlan will detect this label as
an internet link. The text will get an underline automatically, to mark that this is an internet link.
 

 
If you follow this link, your browser will open and try to connect to the specified site. In this case
the browser will connect to our homepage.
 
 



Printing
 
sPlan is equipped with a comfortable preview for printouts. So you can always see what effect an
option will have, before you waste any paper. You can select the printer, adjust the scale and the
position of the printout, and so on.
 
Select Print... from the File menu, or press the corresponding button in the toolbar to open the
preview window.
 

 
The preview will be more precise, if you maximize the preview window.
 
On the left of the preview window you find the print options. The white area on the right
represents the paper sheet and the red frame indicates the printable range of your printer. A
page can be selected on the bottom of the preview. The printer name is displayed in the headline.
 
Changing the position of the printout
The position of the printout is adjustable directly in the preview. You can move the diagram to the
required position on the white paper. Click to the diagram in the preview and move it to the
wanted position, while holding down the mouse button.
 
Scaling
Select the option "1:1" if no scaling is required.



Select "User" to change the scaling with the slider.
 
Caution: Mostly printers can not print exactly to the edges of the paper. If your diagram uses the
full paper format you will have to choose a scaling of about 95% to avoid clipping printouts.
 
Selecting paper orientation
The printer should use the same orientation as the page format, that you have entered for the
page. Otherwise you will asked to change the printers paper orientation.
 
Page size
Select this option to display the size of the page as a light grey background. The page size is only
visible in the preview. This option has no effect on the printout.
 
Printing selection
Here you can select if you want to printout only the current page, all pages or a selection of
pages. If marked selection, you can click on the "..." button to select several pages of your
project.
 
Fit to page
Click this button to fit your diagram to the paper automatically.
 
Center
Click this button to adjust the diagram in the center of the paper.
 
Apply
If you press this button, all current settings like scaling, orientation or the position will be applied
to all other pages of your project.
 
Setup
This button calls the setup dialog for the available printers. Here you can choose a printer, and
you can call the setup dialog for the selected printer.
 
Print
This button starts the printout.
 
Close
Use this button to close the print preview without printing.



Exporting circuit diagrams
 
If you wish to use a circuit diagram with other applications, you can export it to a common
format. You can choose between 4 file formats:
 

GIF
JPG
BMP
EMF

 
GIF, JPG and BMP are files in pixel format.
sPlan is working with vector graphic. The conversion of a vector graphic to a bitmap graphic is
always lossy. To keep the loss small, you can choose a high resolution.
 
GIF and JPG are compressed files, which keeps the file size small
BMP is a uncompressed file format and produces large file sizes.
We recommend using the GIF or the JPG format.
 
The EMF-format is a vector format and so it produces high quality exports. But unfortunately this
format causes problems in many applications. You can export this format and try to import it in
your application. If you have any problems with this format within your application, you should
not use it anymore. Please select another export format like JPG to use it with your application.
 
The Export function is available from the File menu.
 

 
Filetype
You can choose either GIF,JPG, BMP or EMF for the export format.
 
 
Size (only GIF, JPG and BMP)
Use the slider to adjust the bitmaps resolution. Keep in mind that high resolutions (high quality)
need more memory resources, than lower values. The necessary memory is being displayed (only
BMP). Try to reduce resolution as much as you can, with acceptable quality. This is most
important with colored bitmaps.
 
Color (only BMP)
Whenever possible you should select B&W, to reduce the bitmaps size. Only select COLORED if



you really use colored objects in your diagram. A monochrome bitmap that uses 500 Kbytes
needs about 12 Mbytes if exported in colored mode with the same resolution! This may take some
time.
You can use B&W even if the diagram contains colored object, to save resources.
You can monitor the required memory, when you make changes to color or resolution.
 
Close the dialog with OK to create the export file. A file dialog will open, so you can enter a
filename. Select the directory where the file should be created, otherwise you may not find it
later.
 
 



AutoSave
 
This option can be used for automatic saving within given intervals. Select Autosave... from the
File menu to activate this feature and adjust the interval.
 

 
If AutoSave is activated, sPlan will save your work regularly to a backup file. The backup file has
the same filename as your project, but the extension will be changed to *.bak.
 
Don't forget to save your work regularly, even if AutoSave is activated. The backup feature was
just designed to give you additional safety.
 
Whenever you have to restore work from a backup file, you can exchange the ".bak" extension to
".spl". After that you can load this file like any other sPlan-file.



Defaults for directories and fonts
 
You can define default-directories and default-fonts for the work with sPlan. Select the entry
Defaults... from the Options menu.
 

 
In this dialog you can define defaults for the working-directories and the fonts.
 

If you select the option "Remember last used directories" , sPlan will notice the
directories you used last if you exit the software. The next time you start sPlan, these
directories will be the default directories.
If you select the option "Set default directories on start up" , sPlan will set the default
directories to the given directories every time on start up.

 
The settings for the default fonts are equal to the settings of the directories. You can also define
fixed fonts for every start up, or you can set the "remember" option.



Keyboard controls
 
You can control many functions of sPlan with your keyboard.
 
Often needed functions like copy, paste, delete, duplicate, etc. can be called with special hotkeys.
These hotkeys were displayed in the main menu right beneath the entry.
 
Additional functions are available:
 
Moving elements with the cursor keys
Selected elements can be moved with the cursor keys. They will move always one grid. If you
press the SHIFT-key simultaneously, you can move the elements in 1/10 mm steps.
 
Selecting elements with the TAB-key
You can select elements one after another with the TAB-key. Every time you press the TAB-key
the next element will be selected. If you press the SHIFT-key simultaneously, the last element will
be selected instead of the next.
 
Calling the property dialog with ALT-Return
You can call the property dialog of a selected element by pressing ALT-Return. This will only work
if exact 1 element is selected.
 
Zoom with the keyboard
F5 zooms to the whole page
F6 zooms to all elements on your diagram
F7 zooms to all selected elements on your diagram
+ zoom in
- zoom out
 
Follow an active link
With F8 you can follow an active link . The active link has to be selected for this.
 
 



Software registration
 
You can send us your registration form, to get information about updates and new ABACOM
products.
 
Note:
If you received your software directly from ABACOM , a registration is not necessary.



Tips and hints
 

You can always go back to the standard (arrow) mode, with the right mouse button (except
the zoom mode)
You can always disable the grid capture temporary with the SHIFT-key. So you don't have to
switch the grid on or off.
You can always disable the angle capture while drawing lines or rotating elements temporary
with the CTRL-key.
If you click on a selected element again, the sizer will change into arrows. Now you can
rotate or shear the element with your mouse.
If you have selected a line or a polygon, you can move single line-segments of the line or
the polygon, while you keep the CTRL-key pressed.
If you press the SHIFT-key while rotating or mirroring, the text won't be rotated or
mirrored. You may have to align the text new, but therefore the text is always readable.
You can change the text positions of the identifier, value or contacts of a component directly
in your diagram. Just click on the text element and move it (the component should not being
selected before). There is no need to call he component editor for this.
You can zoom with your mouse wheel, if you keep the CTRL-key pressed.
If you want to create a circle with a dashed line, you can create with the special form
function a regular polygon with enough edges (e.g. 32 ore more) as a line. After that, you
can doubleclick on the "circle" and define a line style.
You can easily sort your components in the library per drag&drop. Just click on a component
in the library and move it to the new place in the library.
You can adjust the width of the library with the mouse.
You can add your own form sheets to your circuit diagram
You can simply draw magnetic lines out of the rulers. To delete magnetic lines, just draw
them back to the ruler.
If you want to publish your circuit diagrams in the internet, you should export the diagram
with a high resolution. After that you can shrink the picture with a graphic application. This
will result in a very good quality, because most graphic applications use anti-aliasing to
shrink pictures.
As an alternative way, you can offer your *.SPL files for download, and refer your visitors to
the free viewer application for sPlan.



The Viewer
 
The Viewer is used to view and print sPlan files (*.SPL), without installation of the sPlan editor
software.
 
The viewer is a single EXE-file: SPLAN-VIEWER60.EXE
 
The Viewer may be distributed freely, so everyone can view and print sPlan circuits.
 
After the installation of sPlan, the Viewer can be found in the installation directory of your sPlan
software.
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